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Welcome

Welcome to Huntsville Operations Support Center (HOSC) training provided by the HOSC 
Training Team (HTT). 

If you are interested in scheduling additional training, submit a training request form via the 
Internet. The homepage can be accessed at:

http://mole.msfc.nasa.gov/hosc_training/htt.html

Another option is to contact the HOSC Training Coordinator, Dawn Schell, at (256) 461-4927.
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Training Contacts

If you have questions regarding training, contact your EO62 training representative or one of the 
following individuals:

Workbook Overview

The majority of the workbooks are designed to be self-paced requiring very little assistance from 
an instructor. The following table lists the workbooks and their associated course number:

Name Organization
Phone 

Number
E-mail Address

Lisa Watson EO39 544-3523 lisa.watson@.msfc.nasa.gov

Kim Lankford, HTT Lead NTI 461-4536 kim.lankford@ums.msfc.nasa.gov

D.C. (Sparky) Goodman NTI 461-4545 sparky.goodman@ums.msfc.nasa.gov

Michelle Adrian NTI 461-4514 michelle.adrian@ums.msfc.nasa.gov

Dawn Schell NTI 461-4927 dawn.schell@ums.msfc.nasa.gov

Gene Sobczynski NTI 461-4516 eugene.sobczynski@ums.msfc.nasa.gov

James (Jay) Washburn NTI 461-4543 james.washburn@ums.msfc.nasa.gov

Anthony (Mac) McCoy bd Systems 461-4532 anthony.mccoy@ums.msfc.nasa.gov

Workbook Numbering System

Workbook 
Number

Title
Associated 

Course

Workbook 1 HOSC End-User Software Training HOSC-1000
HOSC-1010
HOSC-1020
HOSC-1030

Workbook 2 Using the Databases HOSC-2050

Workbook 3 Using the Exception Monitor Application HOSC-2060

Workbook 4 Using the Display Generation and Operation 
Applications

HOSC-2070

Workbook 5 Using the Computation Generation and Operation
Applications

HOSC-2080

Workbook 6 Using the Scripting Applications HOSC-2090
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This workbook cover course:

HOSC-2090 - Using the Scripting Applications

This course will provide the trainee with the information necessary to develop scripts to perform a 
sequence of computer instructions using the Script Generation and Script Operation applications.  
Additional material is provided to provide the trainee with instructions on the use of the Scratchpad 
Line application.

Workbook 7 Using the NRT Data Request Applications HOSC-2100

Workbook 8 Using Applix HOSC-2110

Workbook 9 Using FrameMaker HOSC-2130

Workbook 10 Using Electronic Mail HOSC-2140

Workbook 11 Using the Payload Information Management System (PIMS) HOSC-2150
HOSC-2160

Workbook 12 Using the Pixmap Editor HOSC-2170

Workbook 13 Using the Ground Support Equipment Packets Application HOSC-2180

Workbook 14 Using the Strip Chart Recorder Applications HOSC-2190

Workbook 15 Using the End-User Command Applications HOSC-2120

Workbook 22 Workstation Overview and General Purpose Utilities Training HOSC-1040

Privileged Applications

Workbook 16 Using the Privileges within the Database Applications HOSC-3000

Workbook 17 Using the Command System Management Application HOSC-3010

Workbook 18 Using the User Configuration Management Application HOSC-3020

Workbook 19 Using the System Monitor and Control Applications HOSC-3030
HOSC-3040

Workbook 20 Using the Data Packet Generator Application HOSC-3050

Workbook 21 Using the Database Monitor and Control Application HOSC-3060

Workbook Numbering System (Continued)

Workbook 
Number

Title
Associated 

Course
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Workbook Layout

The workbooks include a welcome section that details how the document is divided into modules as well 
as what is contained within each module. The modules include a discussion of the main topic of the 
module, a step-by-step “Try It...” and review questions. Modules have been included that “put it all 
together” and provide exercises to reinforce what you have learned.  

This particular software is provided to assist you, the user, in the development and operation of scripts. 
Scripts are essentially text files made up of statements (directives) which are interpreted from high level, 
English-like statements into a sequence of computer instructions.  This course will provide a thorough 
introduction to the purpose and structure of the software and will set you on a path toward developing 
your own scripts.

This workbook and the accompanying course is divided into four modules.  Each of the first three 
modules cover a particular application in the realm of scripting and provide you with a number of 
exercises in which you will create and operate scripts.  The fourth module serves the dual purpose of 
providing both an overview of the scripting language and an assortment of scripting exercises to fine-
tune your skills.

Each module features an exercise which will apply the skills you acquire during the course The four 
modules include:

Module 1:  A First Look at Scripting
Module 2:  Operating and Controlling Your Scripts
Module 3:  Using the Scratchpad Line
Module 4:  Working with the Scripting Language

Given the extensive technical requirements, extreme effort has been taken to make the software as 
intuitive and user-friendly as possible.  Hopefully, your experience with the software will be rewarding, 
and you’ll find it satisfies your individual needs. 
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Workbook Objectives

At  the completion of this workbook, you should be able to:

■ Write simple scripts
■ Operate validated scripts
■ Use Scratchpad Line directives to invoke operations
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Module 1
A First Look at Scripting

The scripting applications provide the capability to create, edit, validate, and operate scripts. Scripts are 
text files containing statements (or directives) which the script parser can recognize. Scripts can initiate 
computations, displays, command update forms, and other scripts. Scripts can also be used to uplink files 
and commands.

Unlike computations, which are compiled into the computer’s machine language, scripts are interpreted 
from high level, English-like statements into a sequence of computer instructions. Because scripts are 
interpreted rather than compiled, it is easier to control their operation although they do not have the 
power or speed of a full programming language such as C or FORTRAN.

In this module, we will discuss the Script Generation application.  This application allows you to validate 
the script directive syntax, referenced database elements, and data type usage. You may also optionally 
check to determine whether User-generated Data Elements (UDEs) referenced in a script are locally 
available to run on the workstation.

Upon completing this module, you will be able to create a simple script.

The Script Generation main window (Figure 1-1, Script Generation main window) is a simple text editor 
and includes a number of menus which provide you with editing, navigation and validation functions:

Figure 1-1, Script Generation main window
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The large area in the middle of the screen is the area in which you will create your script.  Any 
messages generated by the application itself will be displayed the Messages: area at the bottom of 
the screen.

The File menu includes those menu items that allow you to create and save script files, open 
existing script files, setup the printer, print script files, and exit the application.

The Edit menu includes those menu items that allow you to manipulate the text of the script file in 
the full screen editor including cut, copy, paste, clear, and delete functions. Other items available 
from this menu include undo and select all as well as find and replace functions. 

The View menu includes those menu items that allow you to configure the main window including 
the message area and the time reference.

The Navigate menu includes those menu items that allow you to move quickly from one point to 
another within the script file you are editing. Functions include moving to the top or bottom of the 
file, the cursor, a specific line number, and to the beginning or end of the current line. You may 
also advance one word forward or backward.

The Validate menu includes menu items which allow you to validate the script you develop for 
correct syntax and to check that all referenced User-generated Data Elements (UDEs) are present 
on your local platform.

The Help menu provides an index of help topics and provides help on the Script Generation main 
window, defined keys, and the application version.   

Exercises

Instructions The following “Try It” allows you to create your first script.  Carefully read 
and complete each step.   

Scenario You arrive on console for a simulation and log into the workstation.  You 
know that for every support you will be viewing the same displays.  To 
automate this setup, you decide to write a script.  This particular script will 
not require any user input other than to start the script itself.  You will also 
not need to incorporate any of the Scripting Language’s logic structures to 
complete this task.

Try It... Let’s create a simple script that functions as a “batch file” and starts a series 
of displays. Go through the following step-by-step exercise to create this 
script.  This is the simplest form of a script. We will explore logic structures 
and telemetry sampling later in this course.
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1. Before begininng this exercise, be sure you have the following files on 
your workstation.  If you do not, ask your instructor for assistance in 
retrieving them.  The files include:

Displays:
    ISSTEST
    ISSOUTPUT
    ISSPRIMOBJ    

2. Click the Generation menu on the Launchpad and select Script 
Generation.

3. Enter the following script.  On the lines which do not begin with a 
semi-colon (;), pay careful attention to carriage returns.  Whitespace is 
vitally important to a script, unlike the ‘C’ programming language.

BEGIN_SCRIPT batch_script

;+++++++++++++++++++++++++++++++++++++++++++++++
;    This is a script that will start three 
;    displays.
;+++++++++++++++++++++++++++++++++++++++++++++++

DECLARATIONS
  SYSTEM_SECTION
  GLOBAL_SECTION
  LOCAL_SECTION
END_DECLARATIONS

start display ISSTEST
start display ISSOUTPUT
start display ISSPRIMOBJ

;+++++++++++++++++++++++++++++++++++++++++++++++
;   Wait 45 seconds (which represents your shift)
;   and then shut everything down at the end
;+++++++++++++++++++++++++++++++++++++++++++++++

wait 45
write “Stopping all displays”
stop display all
write “End of shift - End of batch file”

END_SCRIPT

4. Select the File menu from the Script Generation main window and 
click Save As.... In the dialog box, use the filename “script1_xxx”, 
where xxx are your initials. Click Save.
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5. Validate your script by selecting Validate from the Validate menu.
On the dialog box that appears, click on Validate.  When validation is 
complete and error-free, close the dialog box.

Notice that you saved your script before validating it.  This is a feature 
unique to scripts.  You must save your script prior to validation because 
the software actually validates the file on the workstation disk, not the 
script in memory. If you make changes and then validate without saving 
the changes, the previously saved version of the script will be validated.  
Unsaved changes are not validated.  Save before you validate.

6. Now that you’ve ensured that your script contains the correct syntax, it 
is a good idea to verify that you have all referenced UDEs on your 
workstation.  To do this, select Check for UDEs from the Validate 
menu.  If all of your UDEs appear in the Found: list, close the dialog 
box and get ready to operate your valid script.

If any UDEs are missing or your script did not validate correctly, ask 
your instructor for assistance.

The next module will guide you through the process of operating this 
script.  You will be introduced to more advanced scripting techniques in 
Module 4.
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Module 2
Operating and Controlling Your Scripts

Operating scripts and exercising control over their flow of execution is accomplished using the Script 
Operation application. In the previous module, you created a simple script.  In this module, we will first 
learn about the Script Operation application so that you can operate the script you have created.  We will 
then look at more advanced script control techniques available in this application.

The Script Operation application will only work with validated scripts; therefore, you should always 
validate your script for syntax within the Script Generation application.

When you initiate the Script Operation application (Figure 2-1, Script Operation main window), the 
main window appears as follows:

Figure 2-1, Script Operation main window

The File menu includes those menu items that allow you to open script files, set up the printer, print the 
ouput log (which appears in the Standard Output: area of the main window), and exit Script Operation.
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The View menu includes those menu items that allow you to configure the main window including 
the message area, the time reference, and the control panel.  A menu item is also provided that 
allows you to clear the standard output log.

The Directives menu contains a number of frequently used directives.  Selecting one of the items 
from this menu places the associated directive in the Script Control: text input field on the main 
window work area where you can type in the necessary information to complete the directive 
before it is issued.

The Validate menu includes a single menu item which allows you to check that all referenced 
User-generated Data Elements (UDEs) are present on your local platform.

The Options menu includes those items which allows you to control the execution of the script as 
well as to choose whether the script file text field will scoll automatically or manually.

The Help menu provides an index of help topics and provides help on the Script Operation main 
window, defined keys, and the application version.  

Exercises

Instructions The following “Try It” allows you to execute the script you created in the 
previous module.  Carefully read and complete each step.   

Scenario Now that you have written you script to automate your console setup, you 
are ready to see if it works.  You have validated your script in the Script 
Generation application and you are ready to start you script.

Try It... Let’s open the validated script we created in the previous module and 
operate it:

1. Click the Operation menu on the Launchpad and select Script 
Operation.

2. Select the File menu from the Script Operation main window and 
click Open.... In the dialog box, type the filename “script1_xxx”, 
where xxx are your initials.  Or, you can click on the filename under 
which you saved the validated script you created in the previous 
module.  Click Open.

3. If you did not check that all the referenced UDEs in your script are 
available on your workstation, Script Operation allows you to do this 
without leaving the application.  From the Validate menu, select Check 
for UDEs.  If all of your UDEs appear in the Found: list, close the 
dialog box and get ready to operate your valid script.
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If any UDEs are missing, ask your instructor for assistance.

4. Click Start to begin execution of your script. The script should initiate 
a computation, wait 30 seconds, and then start three displays.  After 
waiting approximately 45 seconds, the script will then shut down all 
displays and the computation.

Once the computation has completed its run, put Script Operation into 
Step mode so that you have total control over the script:

5. Click Start to initiate the script.

6. Immediately click Step to enter Step mode.

Also keep in mind that you can cause your script to immediately enter 
Step mode on its own by including the scripting directive Step On at the 
beginning of your script.  We will do this in the next exercise.

7. Notice that your script pauses.  Click Resume to execute the next 
statement in the script.  Continue clicking Resume and watch as each 
statement executes until the computation and the two displays are 
operating.

8. Let’s force the script to open another instance of the three displays 
already running by causing it to resume operation at the statement 
which opens the first display.  

To accomplish this, make sure the script is paused but is NOT in step 
mode.  You can identify that this is the correct state by looking at the 
pushbuttons on the control panel.  Pause and Step Off will be grayed 
out whereas Resume and Step will be active.  

From the Directives menu, select Resume At....  The directive Resume 
At appears in the Script Control: input text field.  Enter 25 and press 

.

Be sure that line 25 is the statement start display training01.  Since you 
may have entered the script differently than another student, your line 
number may differ.  If so, enter the line number of the statement start 
display ISSTEST.

9. Now click Step Off to exit Step mode.  The script should finish 
executing, eventually shutting down all six instances of displays as well 
as the computation.

Enter
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In the next module, we will discuss the Scratchpad Line application, a sister 
application to the Scripting software that provides you with a command line 
interface for initiating displays and computations as well as updating and 
uplinking commands.
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Module 3
Using the Scratchpad Line

The Scratchpad Line application provides a specialized command line interface that provides immediate 
access to initiating displays, scripts, and computations as well as updating and uplinking commands.

This application provides an interactive command line used to perform tasks such as updating and 
uplinking commands. Other tasks that can be accomplished using Scratchpad Line include starting User-
generated Data Elements (UDEs), stopping UDEs, activating command update forms, updating external 
pseudo Measurement/Stimulus Identifiers (MSIDs), and updating computation constants.

None of the logic and conditional directives or looping constructs supported by the Scripting Language 
are available in Scratchpad Line. Thus, there are fewer directives available in Scratchpad Line than in 
Script Generation. 

When you initiate the Scratchpad Line application (Figure 3-1, Scratchpad Line main window), the main 
window appears as follows:

Figure 3-1, Scratchpad Line main window

The File menu includes a single item which allows you to exit the application.

The View menu includes those menu items that allow you to configure the main window including the 
message area and the time reference.

The Directives menu provides a series of cascade menus which contain the available directives. 
Selecting one of the items from a cascade menu clears the current text and places the associated directive 
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in the Directive: text input field on the main window work area. You then type in the necessary 
qualifiers to complete the directive before it is issued.

The Help menu provides an index of help topics and provides help on the Scratchpad Line main 
window, defined keys, and the application version.  

The following directives are available for use in the Scratchpad Line application:

 Buffer cascade menu

Buffer Command

Syntax
buffer command mnemonic [sub-field1=value1
sub-field2=value2,...] 

Buffer Send

Syntax
buffer send [cmd_position_number_in_group] 

Buffer Clear All

Syntax
buffer clear all

Buffer Clear Last

Syntax
buffer clear last

 Start cascade menu

Start Comp

Syntax
start comp comp_name (datamode,tdb_version,
priority,tbs_1,tbs_2[,input_file,output_file])

Start Display

Syntax
start display disp_name [x_pos y_pos] [datamode 
tdb_version]
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Start Script

Syntax
start script script_name [(arg1...argN)]
[IN filename] [OUTPUT output_filename] [datamode 
tdb_version]

 Stop cascade menu

Stop Chain

Syntax
stop chain chain_name

Stop Group

Syntax
stop group group_name

Stop Comp

Syntax
stop comp comp_name(datamode,tdb_version,priority,
tbs_1,tbs_2[,input_file,output_file])

Stop Comp All

Syntax
stop comp all

Stop Display

Syntax
stop display disp_name [datamode tdb_version]

Stop Display All

Syntax
stop display all

Stop Script

Syntax
stop script script_name [datamode tdb_version]
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Stop Script All

Syntax
stop script all

 Update cascade menu

Update Command Form

Syntax
update command form command_mnemonic

Update Header Form

Syntax
update header form command_header_mnemonic

Update Constant

Syntax
update constant comp_constant_name comp_name 
datamode database value

Update Pseudo

Syntax
update pseudo pseudo_msid with value

 Uplink cascade menu

Uplink Chain

Syntax
uplink chain mnemonic [command_pos_num_in_chain] 

Uplink Command

Syntax
uplink command mnemonic
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Uplink Group

Syntax
uplink group mnemonic [cmd_pos_number_in_group]

Uplink Timetagged Command

Syntax
uplink timetagged command mnemonic

For a complete description of each of these directives, see Scripting Language and Scratchpad Line 
Detailed Specification (HOSC-EHS-2057).

Exercises

Instructions The following “Try It” allows you to try various Scratchpad Line 
Directives.  Carefully read and complete each step.  Please use the same 
displays and computation as you used in the other module. 

Scenario You need to open some displays and start a computation.  To minimize the 
number of steps needed to complete this, you initiate the Scratchpad Line 

application and type in the necessary directive and press .

Try It... 1. Start the Scratchpad Line application.  From the Launchpad’s 
Operation menu, select Scratchpad Line.

In Scratchpad Line, select Directives and click Start Display.  Notice 
that the directive you selected has appeared in the Directive: input text 
field.

2. Type the display name ISSTEST and press . The display will 
appear and the directive you just issued will appear in the Previous 
Directives: list at the top of the main window.

3. Start another display.  In the Directive: input text field, enter start 

display ISSOUTPUT and press .

4. You don’t need to view one of your displays any longer.  From the 
Directives menu, select Stop Display.  The directive appears in the 

Directive: input text field.  Type ISSTEST and press .  The display 
leaves the screen.

Enter

Enter

Enter

Enter
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5. You need to uplink a command.  In the Directive: input text field, enter 

uplink command UHF_POWER_HIGH.  Then press .

If an error occurs, there may be a problem with the command system, or your 
user ID may not be enabled for commanding.  Ask your instructor for 
additional information.

6. You are now ready to shut down the display that has been running during 
your shift.  Since you want to shut down every display running on your 
screen, you can issue the following directive:  stop display all.  Enter the 

directive in the Directive: input text field and press .

At this point all computations and displays should be shut down on your 
workstation and only the Scratchpad Line main window will be visible.

Enter

Enter
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Module 4
Working with the Scripting Language

In the previous modules, you were guided through the process of creating a simple script and you learned 
about using the Scratchpad Line application.  Now it is time to put your new skills to work to create a 
more complex set of scripts by incorporating logic structures and telemetry monitoring.

This module provides you with a number of sample scripts to enter and examine followed by a set of 
exercises that will allow you to develop your own scripts.  To develop your script, you will need to refer 
to Scripting Language and Scratchpad Line Detailed Specification (HOSC-EHS-2057), a document 
which defines the syntax for every directive available in the scripting language.

These sample scripts and exercises use external user-generated data elements such as displays, 
computations, and command update forms.  You will need to retrieve these from the UDE database.  
Refer to the worksheet provided with this workbook for a list of these UDEs.  Ask an instructor for 
assistance in retrieving these UDEs to your workstation.

Exercises

Instructions The following “Try It” allows you to write another script.  Carefully read and 
complete each step.   

Scenario You need to monitor some parameters and based on the value of the 
parameters, UDEs will be invoked and a command will be issued.

Try It... 1. Start Script Generation by clicking on the Launchpad’s Generation 
menu and then select Script Generation.

2. Enter the following script:

BEGIN_SCRIPT askme

;++++++++++++++++++++++++++++++++++++++++++++++++
;     This script demonstrates user interaction,
;     passive and active telemetry sampling,
;     logic structures, and command uplinks.
;++++++++++++++++++++++++++++++++++++++++++++++++

DECLARATIONS
   SYSTEM_SECTION
   GLOBAL_SECTION
   LOCAL_SECTION
      UNSIGNED_INT userval, checkit, telemval
   INTEGER pkt_stat, samp_stat
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END_DECLARATIONS

;++++++++++++++++++++++++++++++++++++++++++++
;     Prompt the user for a value
;++++++++++++++++++++++++++++++++++++++++++++

ask “Enter a value (100-400):” userval

;++++++++++++++++++++++++++++++++++++++++++++
;     Wait until MSID E71M0003P is greater
;     than userval or 20 seconds passes and
;     then start the display ISSPRIMOBJ.
;     This uses passive telemetry sampling
;     in the wait statement.  ‘C@’ designates
;     that we want to convert the value of
;     the MSID from hex to an integer.
;++++++++++++++++++++++++++++++++++++++++++++

wait (C@E71M0003P > userval) 20
start display ISSPRIMOBJ

   
   ;+++++++++++++++++++++++++++++++++++++++++++++
   ;     Now we will use active sampling to
   ;     determine the value of the MSID
   ;     E71X2003E is 1 (ON).  At that point
   ;     we will issue the command UHF_POWER_HIGH
   ;     Note the ‘;;’ at the end of the first
   ;     line of code below.  This designates
   ;     that the next line of code is a
   ;     continuation of the statement (i.e., it
   ;     is not to be treated as the end of
   ;     the statement).  This allows you to
   ;     split long lines of code into two physical
   ;     lines without causing a syntax error.
   ;+++++++++++++++++++++++++++++++++++++++++++++

   telemval = 0
   while (telemval == 0) do
   
   sample new E71X2003E conv into telemval;;
     packet_status pkt_stat sample_status samp_stat
   write “Packet status: “, pkt_stat
   write “Value of E71X2003E:  “,telemval
   wait 1
   
   endwhile
   
   uplink command UHF_POWER_HIGH 

write “All done...”
stop display all

END_SCRIPT
Module 4 4-2 Workbook 6



Wo
3. Select the File menu from the Script Generation main window and 
click Save As.... In the dialog box, use the filename “askme_xxx”, 
where xxx are your initials. Click Save.

4. Validate your script by selecting Validate from the Validate menu.
On the dialog box that appears, click on Validate.  When validation is 
complete and error-free, close the dialog box.

5. Select Check for UDEs from the Validate menu.  If all of your UDEs 
appear in the Found: list, close the dialog box and exit Script 
Generation by selecting Exit from the File menu..

If any UDEs are missing or your script did not validate correctly, ask 
your instructor for assistance.

6. Click the Operation menu on the Launchpad and select Script 
Operation.

7. Select the File menu from the Script Operation main window and 
click Open.... In the dialog box, type the filename “askme_xxx”, where 
xxx are your initials.   Click Open.

8. Click Start to begin execution of your script. The script will prompt 
you for a value.  The script will then wait until the MSID’s value 
exceeds the value you provided and then start a display.  After waiting 
approximately 45 seconds, the script will then shut down the display 
and print the words “All done...” in the output area.

Additional 
Exercises

1. Write a script which updates a command form and then uplinks the 
command when a certain MSID’s value is greater than 300.

2. Write a script which would start a computation which uses as input the 
computation constant $CINPUT_TEMP.  Have the script update the 
constant with the value of an MSID.
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Course Summary

Scripts are essentially text files made up of statements (directives) which are interpreted from high level, 
English-like statements into a sequence of computer instructions. Script Generation allows the user to 
create, edit, and validate such scripts while Script Operation allows you to initiate, monitor and control 
their execution. 

Scratchpad Line directives allow you to perform tasks at a command line level.
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Questions

Instructions Indicate an answer for each question below. The correct answers are given 
immediately following the questions.

Script Generation/Operation Questions

1. Name three activities that a script can accomplish?

2. True or False.  A script can operate without being validated.

Scratchpad Line Questions

1. What is the purpose of the Scratchpad Line application?

2. You want to stop all of your displays simultaneously.  What is the 
directive that you would use?

3. Describe the steps that are needed to re-execute a previous Scratchpad 
Line directive.
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Answers Script Generation/Operation Answers

1. Starting displays, starting computations, uplinking commands, updating 
pseudos, etc.

2. False

Scratchpad Line Answers

1. The Scratchpad Line application provides an interactive command line 
used to perform tasks such as uplinking commands, command groups, 
update external pseudos, update computation constants, start displays, 
computations, scripts, and terminate them.

2. stop display all

3. Select the directive from the Previous Directives area of the SPL main 

window and press .Enter
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Abbreviations and Acronym List
 A

A/G Air-to-Ground

A/M Automatic/Manual

ADQ Average Data Quality

AIS Automated Information Security

ANSI American National Standards Institute

AOS Acquisition of Signal

API Application Programming Interface

APID Application Process Identifier

Application Process Interface Definition

APT Active Process Table

AR Action Request

ASCII American Standard Code for Information Interchange

AST Active Server Table

ATT Attitude

B

BFS Backup Flight System

BG Bit-contiguous Group

BPDU Bitstream Protocol Data Unit

C
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C Counter-dependent

C C Programming Language

CADU Channel Access Data Unit

CAP Command Acceptance Pattern

CAR Command Acceptance Response

CCBD Configuration Control Board Directive

CCP Central Command Processor

CCSDS Consultative Committee for Space Data Systems

CDB Command Database

CDD Command Data Definition

CDQ Current Data Quality

CLI Command Line Interface

CM Configuration Management

CMATS Configuration Management Asset Tracking System

CMD Command

CNT Countdown Time

COTS Commercial-Off-The-Shelf

CPU Central Processing Unit

CRC Circular Redundancy Check

CRR Command Reaction Response

CSCI Computer Software Configuration Item

CSM Command System Management

CSS Command System Services

CSS Coarse Sun Sensor
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CUI Common User Interface

D

DADS Data Acquisition and Distribution Services

DAE Data Acquisition and Extraction

DARL Database Access Routine Library

DB Database

DBA Database Administrator

DBCG Database Coordination Group

DBCR Database Change Request

DBD Database Developer

DCM Document Configuration Management

DCR Database Change Request

DCRG Distributed Control Room Graphics

DD AP Data Distribution Address Processor

DD NS Data Distribution Network Server

DDQ Data Data Quality

DDS Data Distribution System

DEMOS Distributed Earth Model Orbiter Simulation

DG Display Generation

DMC Database Monitor and Control

DMC Data Management Checklist

DO Display Operation

DOSH Database Operational Support History
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DP Distribute Packet

DPU Data Processing Unit

DQ Data Quality

DSID Data Stream Identifier

DSN Deep Space Network

E

EC Experiment Computer

ECR Engineering Change Request

EGSE Experiment Ground Support Equipment

EHS Enhanced HOSC System

ELF Extremely Low Frequency

EM Exception Monitor

EML Extract MSID Library

ES Expected State

F

FDDI Fiber Distributed Data Interface

FEP Front-End Processor

FEPSC Front-End Processor Status and Control

FIFO First-In-First-Out

FPTNM Foot-Pounds to Newton-Meters

FSS Fine Sun Sensor

FSV Flight System Verifier
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FTAM File Transfer Access and Management

FTP File Transfer Protocol

G

GB Gigabyte

GCID Ground Correlation Identification

GMT Greenwich Mean Time

GPC General Purpose Computer

GPS Global Positioning System

GSE Ground Support Equipment

GSFC Goddard Space Flight Center

GUI Graphical User Interface

H

H/W Hardware

HAMASE HOSC Automated Model and Screen Editor

HAPS HOSC Advance Planning System

HASA HOSC Administrative Software Account

HASS HOSC Activity Scheduling System

HCR HOSC Change Request

HLOG HOSC Automated Logging System

HOSC Huntsville Operations Support Center

HPR HOSC Problem Report

HSR HOSC Support Request
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HTT HOSC Training Team

HUA HOSC User Assistance

HViDS HOSC Video Distribution System

HVoDS HOSC Voice Distribution System

I

I/O Input/Output

ICD Interface Control Document

ID Identification

IDD Interface Description Document

IDQ Instantaneous Data Quality

IEEE Institute of Electrical and Electronics Engineers

IP Internet Protocol

ISS International Space Station

IST Integrated Support Team

J

JSC Johnson Space Center

K

kbps kilobits per second

KMRTS Kennedy Marshall Redundant Transmission System

KSC Kennedy Space Center
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L

LAN Local Area Network

LDP Logical Destination Processor

LES Limit/Expected State Sensing

LOS Loss of Signal

LOV List of Values

LPS Launch Processing System

LTG Local Table Generation

LTO Local Table Operation

M

M Multi-syllable

MB Megabyte

MCC Mission Control Center

MCCU Mission Control Center Upgrade

MDM Multiplexer/Demultiplexer

MET Mission Elapsed Time

MF Maintenance Fixtures

MH Message Handler

MOC Mission Operations Computer

MOL Mission Operations Laboratory

MOP Mission, Operational Support Mode, and Project

MSFC Marshall Space Flight Center

MSID Measurement/Stimulus Identifier
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MSL Microgravity Science Laboratory

MTBF Mean Time Between Failure

MUPS Momentum Unloading Propulsion System

N

N Normal

NASA National Aeronautics and Space Administration

NASCOM NASA Communications

NASDA National Space Development Agency (Japan)

NCC Network Control Center

NDE Non-operational Development Environment

NDL NRT Data Log

NDL Near Real-Time Data Logger

NEMS NASA Equipment Management System

NG Bit Non-contiguous Group

NGT NASA Ground Terminal

NRT Near Real-Time

NSOC NASDA Space Operations Center

NSTS National Space Transportation System

NTP Network Time Protocol

O

OCC Operations Control Center

OCDB Operational Command Database
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OCR Operations Change Request

OD Operational Downlink

OI Operational Instrumentation

OS Operating System

OSF Open Software Foundation

OTE Operational Test Equipment

P

PAP Payload Activity Plan

PB Playback

PC Polynomial Coefficient

PC Personal Computer

PCAD Pointing Control and Aspect Determination

PCDB Project Command Database

PCM PIMS Configuration Management

PDI Payload Data Interleaver

PDRF Playback Data Request Form

PDSS Payload Data System Services

PFS Primary Flight System

PI Principal Investigator

PID Process Identifier                                                                                                                                                                  

PIMS Payload Information Management System

POCC Payload Operations Control Center

POD Payload Operations Director
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POIC Payload Operations Integration Center

PP Point Pair

PPS Payload Planning System

PRT Packet Routing Table

psi pounds per square inch

P/SS PDSS System Support

PTC Payload Training Complex

PTDB Project Telemetry Database

R

R Range-dependent

RAM Random Access Memory

RCS Reaction Control System

RDBMS Relational Database Management System

RDRP Raw Data Record Playback

RID Review Item Discrepancy

RPM Rounds per Minute

RR Replanning Request

RSS Resident Size

RT Real-time

RTAS Radians to Arcsecs

RTD Radians to Degrees

RTDS Real-time Data System

RTS Requirements Tracking System
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RUM Remote User Machine

RW Reaction Wheel

S

S Super

S&E Science and Engineering

SC State Code

SC Subsystem Computer

SCM Status and Configuration Manager

SCR Strip Chart Recorder

SDT Shuttle Data Tape

SGI Silicon Graphics Indy

SGI Silicon Graphics Incorporated

SL Spacelab

SM System Monitor

SMAC System Monitor and Control

SMCM System Monitor and Control Configuration Manager

SN Space Network

SNMP Simple Network Management Protocol

SOA Science Operations Area

SPL Scratchpad Line

SQL Structured Query Language

SRD Serial Receive Device

SRS Software Requirements Specification
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SS System Services

SSCC Space Station Control Center

SSME Space Shuttle Main Engine

SSUP System Services User Profile

STS Space Transportation System

T

T Typical

TAS Test and Simulation

TBD To Be Determined

TBS To Be Supplied

TCP/IP Transmission Control Protocol/Internet Protocol

TDB Telemetry Database

TDM Time Division Multiplexer

TDRSS Tracking and Data Relay Satellite System

TDS Time Distribution System

TNS Telemetry and Network Services

TNSDP Telemetry and Network Services Distribute Packet

TTY Teletype

U

UDE User-generated Data Element

UDSM User Data Summary Message

UFT Unrestricted File Transfer
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UGSE User Ground Support Equipment

UI User Interface

UPAR User Profile Access Routine

UPD User Performance Data

V

VC Virtual Channel

VCDU Virtual Channel Data Unit

VCID Virtual Channel Identifier

VMS Virtual Memory System

VV Verification and Validation

W

WCP Workstation Command Processor

WEX Workstation Executive

WSGT White Sands Ground Terminal
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Glossary

Accelerator A sequence of keys that provides immediate access to applica-
tion functions. For example,  +  to invoke the New 
menu item.

Activation Type Method used within local table application to activate a group.  
The defined methods are Time and Control.

Active Window The workstation window that has input focus and in which 
keyboard entries impact and may appear.  See “Input Focus.”

Analog A mechanism in which data is represented by continuously 
variable physical quantities.

Application Main Window The primary window of a software application.

Application Process Identifier 
(APID) 

The APID is an 11-bit field that is included in Consultative 
Committee for Space Data Systems (CCSDS) headers.  It 
uniquely identifies the vehicle that created the source packet.

Application Title Bar The bar at the top of a main window that consists of the win-
dow menu button, the title area, and the minimize and maxi-
mize buttons.

Apply Pushbutton A pushbutton that implements any changes made within its 
dialog box, but leaves the dialog box on the screen so that 
additional changes can be made. See “OK Pushbutton.”

Approve In PIMS, this action is taken by a reviewer to signify his/her 
approval that a document, change request, or data request be 
placed in the baselined state.

Archived Database A telemetry database that no longer reflects the current real-
time telemetry characteristic information. Only one archive 
database is available online at a time.

Attributes Defaults Bar The area below the menu bar on the main window where 
application Text:, Line:, and Fill: default attributes are set.

Avtec A manufacturer of telemetry transmit and receive devices used 
in the Huntsville Operations Support Center (HOSC) 
Enhanced HOSC System (EHS) as the primary telemetry pro-
cessing hardware devices.

Baselined In PIMS, the final state of the review cycle. When a document, 
change request, or data request has been approved by all 
reviewers, the approver may place it in the baselined state.

Ctrl N
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Baselined Database Database that reflects the current real-time telemetry or com-
mand characteristic information for a particular mission activ-
ity. Baselined databases have completed validation.

Bitstream Protocol Data Unit 
(BPDU)

A protocol data unit of the bitstream function having a format 
of a header followed by a fixed length block of contiguous bit-
stream data.

Block NASA Communications (NASCOM) 4800-bit block format 
utilized for the transfer of data via the GSFC/MSFC Multi-
plexer/Demultiplexer (MDM) system.

Calibrated Three types of calibration exist for telemetry samples: polyno-
mial, point pair interpolation, and state code conversion. If 
calibration is requested, Telemetry and Network Services 
(TNS) automatically converts the unprocessed sample and 
then performs calibration on the sample for that Measurement/
Stimulus Identifier (MSID) as defined in the local table.

Cancel Pushbutton A pushbutton that allows a user to exit a dialog box without 
implementing any changes.

Cascade Menu A sub-menu or menu-within-a-menu that appears when you 
highlight a menu function that has an arrow to the right of its 
name. Cascade menus are used to group similar functions 
together beneath the pulldown menu.

Caution A standard icon used throughout the user guide set to repre-
sent destructive actions which could result in loss of data.

Caution Limits A range defined by a high and low value for an analog MSID 
in the Telemetry Database (TDB) and Local Table. A color 
code (yellow) represents values within those ranges in the 
application.

CCSDS Packet A source packet comprised of a 6-octet, CCSDS defined pri-
mary header followed by an optional secondary header and 
source data which together may not exceed 65535 octets.

Channel Access Data Unit 
(CADU)

Protocol data unit used for transmission from the ISS to the 
PDSS. A CADU  consists of a CVCDU that has been prefixed 
and delimited by a synchronization marker.

Click The action of pressing and releasing a mouse button. Typi-
cally, this is a left mouse button action.

Coded Virtual Channel Data 
Unit (CVCDU)

A VCDU to which a block of error-correcting Reed Solomon 
(RS) check symbols has been attached.

Command System Manager The position in charge of controlling the commanding system 
utilizing the Command System Managment software.  For 
AXAF projects, this is known as the PAYCOM position.
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Commercial-Off-The-Shelf 
(COTS) Software

Software applications that have been purchased from a com-
mercial software vendor as opposed to those that were devel-
oped internally.

Computation A FORTRAN or C program used to manipulate telemetry 
parameters. These programs are created by the Computation 
Generation application and are executed in Computation 
Operation.

Configuration Management 
(CM) Tools

Institutional applications that allow users to access and per-
form tasks, such as tracking requirements and equipment, 
scheduling resources, and logging into automated problem 
report systems.

Control Indicator Used to indicate that the group will be activated for limit/
expected state (LES) sensing with either the control MSID or 
a control MSID plus delay time.

Control Panel The area of a window where application pushbuttons and 
other graphical components are located.

Converted The process of translating raw telemetry data into an Ameri-
can National Standards Institute (ANSI) standard data repre-
sentation so that the sample can be properly interpreted by the 
machine which processes the data.

Counter-dependent A parameter whose occurrence in telemetry is dependent on 
an incrementing or decrementing counter in the data.

Critical Command A command whose initiation and execution could possibly 
cause damage to a payload or spacecraft and impair the mis-
sion.

Database Administrator An individual who is primarily responsible for managing the 
RDBMS engine and administering database accounts.  He/she 
also has the privilege to edit restricted database fields in any 
database, but is normally not recommended to edit data values 
that drive the telemetry and command processing for the EHS 
system.

Database Coordination Group A working group which includes representatives from the 
appropriate project operations personnel, project source DB 
developers, MOL DB developers and the HOSC validation 
team. Review and approve/dissaprove DBCRs, resolve con-
flicts and evaluate any DB related issues.

Database Developer An individual that has the privilege to edit restricted fields 
(e.g., decom, etc.) for both operational and non-operational 
databases that drive telemetry and command processing for 
the EHS system. 

Dataset A saved set of a command’s modifiable fields used to update a 
command prior to being transmitted.
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Data Stream Identifier (DSID) A field within a Secondary EHS Protocol Header for PDSS 
Payload Data used as a unique identifier for the data stream. 
This bit denotes if the type of data contained therein is 
CCSDS packet data (0) or BPDU (1).

Delivered Database A database must be delivered before it can become pre-
released.  A delivered database has not been validated for 
operational testing.

Delta Limit Maximum acceptable difference between consecutive samples 
of a parameter.

Desktop The computer monitor backdrop area on which all windows 
are opened. May also be referred to as workspace.

Development In PIMS, the first state of the review cycle in which a docu-
ment, change request or data request is still being written or is 
being updated.

Direction Keys A group of computer keyboard arrow keys which allow users 
to move up, down, left, and right within an application or 
menus.

Disapprove In PIMS, the action taken by a reviewer to signify disapproval 
and recommendation against moving a document, change 
request or data request into the baselined state.

Discrete Values Telemetry values that have states (e.g., on or off).

Double-click The action of pressing and releasing a mouse button twice in 
rapid succession.

Drag To press and hold down a mouse button while moving the 
mouse on the desktop (and the pointer on the screen). Typi-
cally, dragging is used while moving and resizing windows.

Drawing Tools Palette A group of tool buttons that is used to create graphic objects in 
order to display telemetry data, initiate commands, and start 
scripts and computations. The palette is located on its own 
floating dialog box or the application window.

Dump During periods when communications with the spacecraft are 
unavailable, data is recorded onboard and played back during 
the next period when communications resume. This data, as it 
is being recorded onboard, is encoded with an onboard 
embedded time and is referred to as dump data. When a near 
real-time (NRT) request is written specifying that dump data 
is desired, the onboard embedded time is used to fulfill the 
request.

Dynamic Objects Graphical objects that represent updating telemetry data.

Ellipse A geometric shape which can be created on a display (i.e., a 
plane of a cone, an oval shape, etc.).
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Expected State Text state code which indicates the nominal value of a param-
eter.

Expert Mouse Actions Clicks or double-clicks of mouse buttons which are non-stan-
dard and which activate special functions.

Filter The filter function is used within a dialog box to refine and 
define subsets of files you want to work with using a string 
search and wildcard. Characters can be used to implement the 
filter function.

Fonts A style of printed text characters.

Graphical User Interface (GUI) A way of interacting with computers using graphics-oriented 
software and hardware.

Grayed out A menu selection item that has been made insensitive, which 
is visually shown by making the menu text gray rather than 
black. Items that are grayed out are not currently available.

Greenwich Mean Time (GMT) The solar time for the meridian passing through Greenwich, 
England. It is used as a basis for calculating time throughout 
most of the world.  Displayed within the HOSC, it follows the 
format ddd:hh:mm:ss.

Grid A pattern of horizontal and vertical lines forming squares of 
uniform size on a display, used as a reference for locating 
points.

Group Parameter Composition Parameter composition where the bits of a parameter are con-
tiguous and a multiple occurrence of that parameter exists as a 
group of samples.

Groups MSIDs which have been grouped together, primarily for use 
with the Exception Monitor (EM) application.

Hazardous Command A command whose initiation and execution could pose a 
threat to human life or the entire mission.

Help A standard icon used throughout the user guide set to indicate 
that a cross-reference is provided to assist in solving problems 
or to answer questions.

Huntsville Operations Support 
Center (HOSC) 

A facility located at the Marshall Space Flight Center (MSFC) 
that provides scientists and engineers the tools necessary for 
monitoring, commanding, and controlling various elements of 
space vehicle, payload, and science experiments. Support con-
sists of real-time operations planning and analysis, inter- and 
intra-center ground operations coordination, facility and data 
system resource planning and scheduling, data systems moni-
tor and control operations, and data flow coordination.

I-beam Insertion Bar A graphical image used to represent the insertion point of text 
in a text entry area which provides a visual cue that text entry 
is anticipated by the system.
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Icon A graphical representation of an object on the desktop. 
Objects can be minimized (iconified) to clear a cluttered 
workspace, and restored (opened), as needed.

Input Focus A window or window element that is activated and available 
for subsequent actions. Input focus is usually indicated by 
highlighting or changing the color of the activated element.

Input Slider An input object that allows users to change values of pseudo 
parameters and computational constants assigned to objects. 
Pseudos can be used in other applications (i.e., scripts, compu-
tations, etc.).

Insensitive An object or area of an application window that does not have 
input focus.

Integrated Support Team (IST) Institutional groups at the HOSC responsible for configuring, 
monitoring, and resolving problems with computer systems 
and application software.

Launchpad A floating menu bar that is used to initiate all HOSC software 
applications.

Legend A table that labels parameters plotted on a chart or grid.

Limit Delta Maximum acceptable difference between consecutive samples 
of a parameter.

Limit/Expected State Sensing 
(LES) 

A configurable option in Display Operation that allows the 
user to select whether he wants to see limit violation status or 
not. The incoming data is compared against the Local Table 
limits.

Limits Defined ranges for a measurement which are used to indicate 
off-nominal conditions: Caution High, Caution Low, Warning 
High, and Warning Low.

Line Plot A plot that uses lines to represent the relationships among 
telemetry values.

Local Table A subset of the TDB stored on a workstation or server used for 
telemetry processing.

Maximize Button A control button that is located to the right of the application 
title bar. When pressed, this button enlarges the application 
window to its largest state.

Menu Bar The area at the top of a window that contains the titles of pull-
down menus.

Merge The combining of data from different sources for a specific 
time slice.  During merge, the best (cleanest) data from each 
source will be used to create a contiguous segment of data for 
the specified time slice.

Message Area The part of the application window where system messages/
responses are shown.
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Message Dialog Box An area that provides information, gives the current status of 
data, asks questions, issues warnings, or draws attention to 
errors.

Mini-Application A secondary main window activated from within a main win-
dow application.

Minimize button A control button located to the right of the application title 
bar. When pressed, it iconifies the window.

Mission, Operational Support 
Mode, and Project (MOP)

A MOP is what delineates one EHS activity from another. 
MOP information is available in the common configuration 
file on every node.

Mnemonic An underlined character on a menu item, that allows users to 
initiate the item by typing letters on a keyboard.  A user-
friendly name used to reference a command residing in the 
command database.

Mode Independent Mode Independent is used to describe any process that is not 
dependent on a data mode.

Modifiable Commands Commands containing at least one data field which can be 
updated during operational activities prior to their uplink 
transmission.

Mouse A pointing device that is used along with a keyboard in point-
and-click user interfaces. The mouse used with HOSC work-
stations contains three mouse buttons. The left mouse button 
is used to activate and select items on windows. The middle 
mouse button is used for move functions. The right mouse 
button is used to access popup menus.

MSID Text Field An output object for viewing telemetry containing a label for 
the telemetry parameter, as well as the current value of the 
parameter displayed in a specified format (i.e., decimal, hex, 
octal, binary, American Standard Code for Information Inter-
change (ASCII), etc.).

Multiple Drawing Mode A mode that allows users to draw multiple objects of the same 
type.

Native Data Type Defined in the database and indicates how the MSID data will 
be interpreted in the HOSC.

Nominal A color code indicating expected conditions within defined 
limits of parameters.

Non-Shareable A flag has been set to prevent other users from retrieving your 
User-generated Data Element (UDE) from the UDE Database 
and using it on their local workstations.

Normal A telemetered parameter that occurs once per packet.

Note A standard icon used throughout the user guide set to direct 
your attention to specific items of concern.
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OK Pushbutton A pushbutton that implements any changes specified within a 
dialog box. The dialog box is dismissed after this pushbutton 
has been selected.

Option Menu Button A pushbutton which, when clicked, displays a menu of related 
options. The selected option is shown as the pushbutton label.

Output Slider An object that displays telemetry parameters. 

Packet A data unit comprised of octets that a source application gen-
erates.

Parameter Composition Describes how the bits of a parameter can be arranged in a 
packet for a sample(s) of that parameter.

Pixmap Object A picture that can be  drawn using the pixmap editor or 
scanned and assigned using the pixmap editor.

Playback Playback data can originate either internally or from some 
other facility. Project servers in the HOSC receive Playback 
telemetry streams from the HOSC Data Distribution System 
(DDS) and perform the same processing as would be per-
formed on real-time telemetry streams.

Pointer Sometimes called the mouse cursor, the pointer shows the 
location of the mouse on the desktop. The pointer’s shape 
depends on its mode. (e.g., on a window frame, the pointer is 
an arrowhead; while you are waiting for an action to com-
plete, the pointer becomes clock).

Point Pair Calibration A measurement which is calibrated using a series of linear 
segments. The linear segments are defined by a pair of points 
for each segment. Each point consists of a raw count value 
and a corresponding engineering unit value.

Pointer Shapes A graphical shape that a pointer assumes in the drawing mode 
(e.g., cross-hairs, I-beams, hour-glasses, etc.).

Polynomial Coefficient Calibra-
tion

A measurement is calibrated using the following polynomial 
calibration equation:
where:   eu - engineering units
cnts - counts
eu = COEF0 + (cnts1 x COEF1) + (cnts2 x COEF2) + (cnts3 x 
COEF3) + (cnts4 x COEF4) + (cnts5 x COEF5) + (cnts6 x 
COEF6) + (cnts7 x COEF7) + (cnts8 x COEF8) + (cnts9 x 
COEF9).

Popup Menu A menu that is invoked when the right mouse button is 
clicked. Functions available are the most common and vary 
from application to application.

Predefined Commands Commands completely defined prior to an operational activ-
ity.  Predefined commands contain no modifiable data fields.
Glossary B-8 Workbook 6



Pre-released Database A database that has been validated for operational testing.  It  
is used to validate UDEs (displays, comps, etc.) prior to the 
baseline release of the database.

Project Telemetry Database Contained within the Telemetry Database, includes the telem-
etry definitions needed to drive HOSC telemetry processing 
for a specific project/mission. The source of the real-time 
telemetry processing tables found in the Telemetry Local 
Table identified by a project/mission/revision prefix. Also 
included are tables to contain user copy data, an error log, and 
an Initial Load Table.

Protocol 1: Provides the formulas for passing messages, specifies the 
details of message formats, and describes how to handle error 
conditions. More importantly, it allows us to discuss commu-
nication standards independent of any particular vendor’s net-
work hardware. A communication protocol allows one to 
specify or understand data communication without depending 
on detailed knowledge of a particular vendor’s network hard-
ware. 2: A term referring to the type of source data used in the 
construction of an EHS packet. EHS Packet Protocols include: 
“C” - CCSDS packet, “P” - pseudotelemetry packet, “T” - 
encapsulated TDM packet, “B” - encapsulated block packet, 
and “D” - TDS packets.

Pseudo MSID/Parameter A parameter identification (ID) that has been assigned to con-
tain the output from a computation.

Pseudo Packet A telemetry packet consisting of external pseudo MSIDs. 
External pseudo MSIDs are generated (either by EHS compu-
tations or scripts), packetized and multicast on the project 
LAN.

Pulldown Menu A list or menu of possible options that is hidden under a gen-
eral phrase and invoked by clicking the left mouse button.

Pushbutton A control that causes an immediate action. To press a push-
button on the screen, point to it and click the left mouse but-
ton.

Radiobuttons A group of buttons that allows users to make only one selec-
tion at a time. Radiobuttons are small diamond-shaped but-
tons.

Range-dependent A parameter whose occurrence in telemetry is dependent on 
the value of a range parameter.

Real-time Data Real-time data is telemetered to the HOSC and distributed for 
immediate use. Real-time telemetry data, received into the 
HOSC system and written to the NRT log, is indexed by its 
time stamps and other identifying information. When an NRT 
request is submitted that covers a particular time slice, this 
indexing information is used to meet that request.
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Recall Text Area within an application that allows users to input up to 256 
characters.

Release In PIMS, an action taken by the manager of a document or 
request that releases it from the baselined state back into the 
development state for modifications.

Resize Borders The area that surrounds the framed area of an application, and 
is used to change the height or width of the window.

Resize Handles Up to eight handles surrounding an object that allows users to 
resize objects, displays, or windows.

Review In PIMS, the second state of the review cycle in which the 
document, change request or data request has been written and 
submitted for review and approval.

Sample Composition Describes how the samples of a parameter are arranged in a 
major frame.

Scatter Plot A plot that uses unconnected dots to represent the relation-
ships among telemetry values.

Scratchpad Line (SPL) Direc-
tives

Provides users with the capability to start and stop displays, 
computations, and scripts. A user may also uplink and modify 
commands and update pseudo MSIDs through the use of SPL 
directives.

Script A file containing a sequence of directives that can be invoked 
in a single step.

Scroll Bar A control that allows the contents of a window area to be dis-
played without resizing a window or list.

Select Button The mouse button used for most operations. By default the 
select button is the left mouse button.

Set Pushbutton A pushbutton that allows a user to implement changes based 
on selections made within a dialog box. Reacts like the OK 
pushbutton and closes the dialog box.

Setup Message Area The dialog box that allows users to change the number of lines 
displayed within the message area of the application main 
window.

Shareable A flag has been set to allow other users to retrieve your UDE 
from the UDE Database and use it on their local workstation.

Shotgun Parameter composition when the bits of a parameter are scat-
tered in multiple non-contiguous words of a major frame.

Slider Box A graphical component of the scroll bar, which is dragged to 
provide a different view of the same file, list, or text area.

State Code Calibration A measurement is converted to a text state code.

Static Object A graphical object that is not receiving telemetry data.
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Status Bar A feature that allows the viewing of application critical con-
figurations within the main window.

Submit In PIMS, an action taken by the manager of a document, 
change request, or data request in which the document or 
request is placed in a state of review and approval and released 
from development.

Subset A collection of measurements from the total measurement set 
that is bounded as an integer number of octets but does not 
constitute the packet itself. A mini-packet.

Super A parameter that occurs more that once per packet.

Superseded Database If a baselined database already exists for a  project and mis-
sion, before a new baselined database can be released, the cur-
rent baselined database is designated as superseded.

Switch MSID A parameter whose value determines which limit or calibra-
tion set will be used for the specified MSID.

TDM Time Division Multiplexed - a technique for transmitting mul-
tiple parameters within a single serial bit stream by interleav-
ing them, one after the other.

Time Indicator Indicates that a group will be activated based on a defined 
start time and deactivated based on a defined stop time.

Time Plot A plot against time containing up to four Y-Axis parameters.

Time Reference A time format that is represented in either GMT or Mission 
Elapsed Time (MET).

Time Tag A time reference marking an event. For example, a parameter 
goes out-of-limits at 230:16:00:00. The time tag for the out-
of-limit event is 230:16:00:00.

Tip A standard icon used within the HOSC user guide set to indi-
cate that suggestions or hints are provided.

Togglebuttons Small buttons that can be switched “on” or “off.” To switch a 
togglebutton, point to it and click the select button. Black indi-
cates that the desired attribute is in effect or “on.”

Tolerance Number of times the MSID exceeds the limit value before an 
EM warning message is issued.

Typical Parameter composition when the bits of a parameter are con-
tiguous.

Unprocessed Raw telemetry data.

User-generated Data Element 
(UDE)

A user-generated file. For example, a display, script, computa-
tion, pixmap, etc., is a UDE.
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User Data Summary Message 
(UDSM)

A PDSS Data Quality packet. Information contained in the 
packet includes: the start/stop time of the UDSM report 
period, the number of unplanned LOS occurrences, the num-
ber of BPDUs or packets per DSID received, the number of 
VCDU sequence counter errors, and the number of packet 
sequence counter errors per DSID.

Virtual Channel (VC) A CCSDS construct whereby a physical communications 
channel is shared among different users, each of whom uses 
part of the available bandwidth for a virtual channel of 
CCSDS CADUs incorporating predetermined CCSDS identi-
fiers for each user.

Virtual Channel Identifier 
(VCID)

A binary identifier located within the VCDU header, which 
when concatenated with the spacecraft identifier, uniquely 
identifies a particular spacecraft virtual channel.

Virtual Channel Data Unit 
(VCDU)

A CCSDS data set of specific structure and fixed length, 
which includes CCSDS specified headers and into which user 
data is packaged for transmission over the space-to-ground 
link.

Warning Limits A color code (red) representing limit violations of a parame-
ter.

Wildcard Placeholders for other characters in a string.  Three wildcards  
are permitted in most HOSC applications. The “*” represents 
any combination of characters and the “?” represents any sin-
gle character. A blank can be used to replace a single “*” to 
indicate “all”.  Database applications use Oracle as their basis; 
therefore, “%” is used like the “*” and an underscore charac-
ter “_” is used like the “?”.  Blank operates the same way in 
database applications as in other HOSC applications and rep-
resents “all.”

Window Menu The menu that appears when you press the window menu but-
ton, which is located to the left of the application title bar on a 
window frame. Every window has a system menu that enables 
you to control the position of the window.

Workspace The area on a terminal where the windows of a user’s environ-
ment appear. The workspace is sometimes referred to as a 
desktop or root window.

XY Plot A plot that contains one X-Axis and up to four Y- Axes 
parameters.
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